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Preface
Welcome to the Genesys 7.6 Proactive Contact Solution Guide. The Genesys 
Proactive Contact solution results from integrating the Outbound Contact 
product with the Genesys Voice Platform (GVP) product. The solution 
provides the ability to proactively initiate and handle outbound campaign calls 
using GVP.
Deploying the Proactive Contact solution requires configuring various 
Genesys products. To prevent the solution configurer from having to consult 
multiple product guides, this guide consolidates proactive contact 
configuration information into one guide. It starts with an overview of the 
Proactive Contact solution and continues with step-by-step instructions for 
configuring the applications and components that are required to run Proactive 
Contact 7.6. It also provides sample building blocks for VoiceXML 
applications.
This document is valid only for the 7.6 release(s) of this product. 

Note: For versions of this document created for other releases of this product, 
please visit the Genesys Technical Support website, or request the 
Documentation Library DVD, which you can order by e-mail from 
Genesys Order Management at orderman@genesyslab.com.

This preface contains the following sections:
Intended Audience, page 6
Chapter Summaries, page 6
Related Resources, page 7
Making Comments on This Document, page 10
Proactive Contact—Solution Guide 5
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Preface Intended Audience
Intended Audience
This document is primarily intended for system engineers and other members 
of an implementation team who will install and maintain Proactive 
Contact 7.6. This guide assumes that you have a basic understanding of:
• Computer-telephony integration (CTI) concepts, processes, terminology, 

and applications.
• Network design and operation.
• Your own network configurations.
This guide also assumes that: 
• You are familiar with the Genesys Framework architecture and functions 

that support Outbound Contact 7.6 and Genesys Voice Platform 7.6. 
• You have already installed and are familiar with the individual Outbound 

Contact and GVP solutions.
• If you choose to report on your Proactive Contact solution activity using 

Genesys tools, you are familiar with the Genesys reporting architecture and 
reporting-related applications—Genesys Info Mart, Stat Server, Interaction 
Concentrator, and GVP Voice Application Reporter (VAR).

Chapter Summaries
In addition to this preface, this document contains the following chapters: 
• Chapter 1, “Overview,” on page 11, provides a high-level overview of how 

the component products operate to provide the Proactive Contact solution, 
including a description of the proactive contact call flow, the deployment 
scenarios that are supported, and a summary of the steps to configure the 
solution.

• Chapter 2, “Configuring Genesys Voice Platform,” on page 23, provides 
detailed information about configuring GVP for the Proactive Contact 
solution.

• Chapter 3, “Configuring Outbound Contact,” on page 37, provides detailed 
information about configuring Outbound Contact for the Proactive Contact 
solution.

• Chapter 4, “Configuring the VoiceXML Application,” on page 49, 
provides information about how user data is passed to and from OCS, and 
about VoiceXML building blocks that are particularly relevant for 
Proactive Contact solution voice applications.

• Chapter 5, “Proactive Contact Solution Reference Information,” on 
page 59, provides reference information about the Framework port, the 
Power GVP dialing mode, the messaging behind a typical call flow, and 
the OBN Error Codes.
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Preface Related Resources
Related Resources
This guide assumes that you have already installed and configured the 
component products listed below.

Outbound Contact
Consult these additional resources as necessary:
• Outbound Contact 7.6 Deployment Guide, which provides architectural 

information, instructions on how to install and configure Outbound 
Contact 7.6 components, configuration option descriptions, and other 
related information.

• Outbound Contact 7.6 Reference Manual, which describes application 
features for Outbound Contact 7.6 and provides information about 
constants, and communication protocols. 

• Outbound Contact Manager 7.6 Help, which describes how to use 
Outbound Contact Manager. 

• Genesys 7.6 Log Events Help, which describes in further detail log event 
messages for Outbound Contact Server and Call Progress Detection (CPD) 
Server, among other products.

GVP
Consult these additional resources as necessary:
• Genesys Voice Platform 7.6 Deployment Guide, which provides detailed 

installation and configuration instructions for GVP. 
• Genesys Voice Platform 7.6 Reference Manual, which provides 

instructions for the administration, provisioning, and configuring of GVP 
and its components. 

• Genesys Voice Platform 7.6 Voice Application Reporter Deployment and 
Reference Manual, which provides detailed installation and configuration 
instructions, and describes the interfaces for the Voice Application 
Reporter (VAR). 

• Genesys Voice Platform 7.6 Voice Application Reporter SDK Developer’s 
Guide, which provides examples on how to develop VoiceXML 
applications that interface with the VAR database and generate application 
reports.

• Genesys Voice Platform 7.6 Troubleshooting Guide, which provides trap 
and basic troubleshooting information for GVP. 

• Genesys Voice Platform 7.6 VoiceXML 2.1 Reference Manual, which 
provides information about developing VoiceXML 2.1 applications on 
GVP. It presents VoiceXML 2.1 concepts and provides examples that 
focus on the GVP implementation of VoiceXML. 
Proactive Contact—Solution Guide 7



Preface Related Resources
• Genesys Voice Platform 7.6 Studio Deployment Guide, which provides 
installation instructions for Genesys Studio. 

• Genesys Studio Help, which provides online information about Genesys 
Studio, a GUI for the development of applications based on VoiceXML. 

Optional Supplementary Solutions

Universal Routing

Consult these additional resources as necessary:
• Universal Routing 7.6 Deployment Guide, which provides a high-level 

overview of Universal Routing features and functions, including product 
architecture, system availability, redundancy information, and deployment 
planning. It also provides instructions for deploying Universal Routing 
components, and describes how to start and stop these components once 
you have configured and installed them. 

• Universal Routing 7.6 Reference Manual, which describes and defines 
routing strategies, Interaction Routing Designer (IRD) objects, Universal 
Routing Server (URS) and other server functions and options, number 
translation, pegs, and statistics used for routing. 

• Universal Routing Business Process User’s Guide. This guide contains 
step-by-step instructions for creating interaction workflows (business 
processes), which direct incoming customer interactions through various 
processing objects. The goal is to generate an appropriate response for the 
customer.

• Universal Routing 7.6 Interaction Routing Designer Help, which describes 
how to use IRD to create routing strategies. It also describes Interaction 
Workflow view, where you create business processes that route incoming 
interactions through various processing objects with the goal of generating 
an appropriate response for the customer.

• Universal Routing 7.6 Routing Solutions Guide, which contains 
information on the various types of routing solutions that can be 
implemented, including skills-based routing, business-priority routing, 
share agent by service level agreement routing, and cost-based routing.

Genesys Info Mart and Interaction Concentrator

Consult these additional resources as necessary:
• Genesys Info Mart 7.5 Deployment Guide, which describes the 

architecture, configuration requirements, and installation steps for Genesys 
Info Mart, including information about specific Interaction Concentrator 
and attached data configuration requirements that allow you to extract 
outbound campaign information directly from one or more Interaction 
Concentrator databases.
8 Genesys 7.6
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• Genesys Info Mart 7.5 Reference Manual for your relational database 
management system (RDBMS), which describes the structure of the 
Genesys Info Mart database and tables.

• Genesys Info Mart 7.5 User’s Guide, which describes how Genesys Info 
Mart populates data for outbound contact attempts.

• Interaction Concentrator 7.6 Deployment Guide, which describes the 
architecture, configuration requirements, and installation steps for 
Interaction Concentrator, including information about how to make data 
from the Genesys Outbound Contact solution available in Interaction 
Database (IDB).

• Interaction Concentrator 7.6 Physical Data Model for your RDBMS, 
which describes the structure of the database and IDB tables.

Genesys
Consult these additional resources as necessary:
• Framework 7.6 Deployment Guide, which describes how to configure, 

install, start, and stop Framework components.
• Framework 7.6 Configuration Options Reference Manual, which provides 

you with descriptions of configuration options for other Framework 
components.

• Framework 7.6 Configuration Manager Help, which describes how to use 
Configuration Manager.

• Genesys 7 Migration Guide, also on the Genesys Documentation Library 
DVD, which contains a documented migration strategy from Genesys 
product releases 5.x and later to all Genesys 7.x releases. Contact Genesys 
Technical Support for additional information.

• Genesys 7 Events and Models Reference Manual, which contains the 
T-Library API, information on TEvents, and an extensive collection of call 
models.

• Genesys Technical Publications Glossary, which ships on the Genesys 
Documentation Library CD and which provides a comprehensive list of the 
Genesys and CTI terminology and acronyms used in this document.

• The Release Notes and Product Advisories for this product, which are 
available on the Genesys Technical Support website at 
http://genesyslab.com/support. 

Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents: 
• Genesys 7 Supported Operating Systems and Databases 
• Genesys 7 Supported Media Interfaces 
Proactive Contact—Solution Guide 9
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Preface Making Comments on This Document
Genesys product documentation is available on the:
• Genesys Technical Support website at http://genesyslab.com/support.
• Genesys Documentation Library CD, which you can order by e-mail from 

Genesys Order Management at orderman@genesyslab.com. 

Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.
When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.
10 Genesys 7.6
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Chapter

1 Overview
This chapter provides an overview of the Proactive Contact solution using 
Outbound Contact 7.6 and Genesys Voice Platform (GVP) 7.6. It introduces a 
description of the configuration needed for this solution.
This chapter contains the following sections:

What Is a Proactive Contact Solution?, page 11
Features and Benefits, page 12
New in This Release, page 14
Component Products, page 14
Proactive Contact Call Flow, page 15
Supported Scenarios, page 18
Summary of Solution Configuration Steps, page 21
Migration, page 22

Note: This document assumes that you can successfully install and configure 
the individual Outbound Contact and GVP solutions. This document 
does not provide installation or configuration information about the 
individual solutions.

What Is a Proactive Contact Solution?
Outbound Contact integrated with GVP provides the ability for Outbound 
Contact Server (OCS) to trigger outbound calls, which are dialed using GVP, 
and to receive responses and results. GVP custom Voice Extensible Markup 
Language (VoiceXML) applications can automatically process the GVP-dialed 
outbound calls for self-service, or the calls can be passed to an agent if agent 
involvement is necessary.

Note: The Proactive Contact solution may also be referred to as Outbound 
Notification.
Proactive Contact—Solution Guide 11



Chapter 1: Overview Features and Benefits
Outbound
Notification

Manager

GVP Outbound Notification (OBN) Manager serves as a gateway between the 
Outbound Contact and GVP solutions that are brought together to enable 
Proactive Contact.
OBN Manager accepts dialing requests from OCS and conveys the request to 
one or more Voice Communication Server (VCS) or IP Communication Server 
(IPCS) machines to create a new outbound connection.
After a connection is successfully established, OBN Manager transfers control 
to VCS/IPCS, and then executes a preprovisioned VoiceXML Interactive 
Voice Response (IVR) application on that outbound connection.

Features and Benefits
The Proactive Contact solution combines the Outbound Contact and GVP 
solutions to provide the following benefits and to make the following 
functionality available:
• Use GVP to automatically dial outbound calls.
• Automatically launch a custom VoiceXML application (voice application), 

and allow it to branch based on the detected call result. For example:
If the call reaches a live person, run any custom self-service 
application.
If the call reaches an answering machine, leave a custom message.

• Store in the calling list the result of the call progress detection, call time, 
other outbound mandatory attributes, and updated user data from the 
custom voice application for each dial attempt. 
Currently supported call results include:

Live person
Answering Machine Detection (AMD)
Fax/Modem
Special Information Tone (SIT) 
Ring No Answer
Busy (or Fast Busy)
Operator Intercept

Note: A TDM Solution with CPD enabled provides all the results listed 
above. For an IP solution, use HMP to get the same call results.

The following outbound-specific actions can be used in the custom voice 
application:

Update the calling record attributes, including the call result and the 
user-specified attributes.
Add a new record to the calling list for future dialing.
Mark the record as DoNotCall (DNC), or cancel the record.
Reschedule the record to be called at a future time.
12 Genesys 7.6



Chapter 1: Overview Features and Benefits
• Apply Outbound Contact treatments to unsuccessful call results. Such 
treatments can be to redial at a specified time or to dial the next record for 
a Busy call result.

• Finalize the outbound call in GVP or send it to an agent for further 
processing.

Reporting
If you use Genesys reporting tools to report on Proactive Contact solution 
activities, you can use the following dimensions for reporting purposes in 
Genesys Info Mart:
• Agent
• Call Disposition (Call Result)
• Campaign
• Campaign Group
• Contact Information Type
• Call Progress Detection (CPD) Disposition (CPD Call Result)
• Custom
• DN
• List
• Record Type
• Tenant
• Time & Date

Note: The only dimension that is slightly different for the Proactive Contact 
solution is the Agent dimension. It is not applicable when GVP does 
not transfer any calls to an agent. Calls are associated with the first 
agent that received the outbound call transfer from GVP. Therefore, 
the call record chain is associated with the agent that was part of the 
last call attempt.

Supported Metrics

The following reporting metrics are applicable for the Proactive Contact 
solution:
• All basic counter metrics
• All snapshot metrics
• All time metrics except:

Engage time
Preview time
Proactive Contact—Solution Guide 13



Chapter 1: Overview New in This Release
Transfer time
Hold time
ACW time
Waiting time

• All operational metrics for GVP-qualified campaigns

New in This Release
The 7.6 releases of OCS and GVP provide the following additional or changed 
functionality for the Proactive Contact solution:
• Enhanced ability to manage the connections between OCS and OBN 

Manager:
New OBN Manager parameters that prevent unwarranted stale records 
in OCS. For more information, see “OCS Retransmit Timeout” on 
page 27 and “Retransmit Interval” on page 28.
New SNMP traps and log messages

• Ability for OBN Manager to obtain the T-Server Call GUID from Call 
Flow Assistant (CFA) as part of the User Data, and to pass the Call GUID 
to OCS for historical reporting purposes.

• Ability to pass the calling party number (ANI) from OCS to OBN 
Manager.

• Ability to propagate SIP Header values to the VoiceXML application on 
IPCS. For more information, see the appendix about SIP Headers in the 
Genesys Voice Platform 7.6 VoiceXML 2.1 Reference Manual.

Component Products
The Proactive Contact solution is enabled through the integration of the 
following Genesys products/servers:
• Genesys Outbound Contact

Outbound Contact Server (OCS) (the dialing engine)
Outbound Contact Manager (the campaigns administration GUI)

• Genesys Voice Platform (the routing engine)
Outbound Notification Manager (OBN Manager)
Voice Communication Server (VCS) for TDM telephony or IP 
Communication Server (IPCS) for IP telephony (the dialer)
Studio (optional—a tool to develop VoiceXML applications)

• Universal Routing (optional—supplementary routing engine)
Universal Routing Server (URS)
Interaction Routing Designer (IRD)
14 Genesys 7.6



Chapter 1: Overview Proactive Contact Call Flow
• Genesys Info Mart (optional—for reporting on Proactive Contact solution 
activities)

• Interaction Concentrator (optional—required as the data collector if you 
are using Genesys Info Mart)

For more information about how OBN Manager enables OCS customers to 
make outbound calls using GVP, see “Outbound Notification Manager” on 
page 12. For more information about how the other Proactive Contact 
components function, see the additional deployment guides that are listed in 
“Related Resources” on page 7.

Note: The GVP components support both single-tenancy and multi-tenancy, 
but not simultaneously.

Proactive Contact Call Flow
The Proactive Contact solution operates in Power GVP mode. Calls are dialed by 
GVP Dialer.
When an outbound call is made using GVP and the contact is reached, the call 
is processed by a custom voice application according to the logic scripted in 
the application. The specific VoiceXML application that is used for all calls 
dialed by GVP for a campaign is specified in the IVR Profile field of the 
Campaign Group object. See page 40 for more information about this field. 
Figure 1 shows the call flow for the Proactive Contact solution.

Note: For completeness, the following diagram shows both IP and TDM 
types of GVP communication server (IPCS and VCS). However, in 
practice, you cannot have both IPCS and VCS in the same GVP 
deployment.
Proactive Contact—Solution Guide 15
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Figure 1: Proactive Contact Call Flow

The proactive call flow is as follows:
1. OCS sends an outbound dialing request to OBN Manager.
2. OBN Manager queues the request in its internal queue.
3. When a call can be placed, OBN Manager sends the request to GVP to 

place a call.
If VCS is used, and if the CPD library is configured, GVP sends a dial 
request to the Dialogic card using the CPD library for advanced Call 
Progress Analysis (CPA) detection. Otherwise, GVP sends the request 
directly to Dialogic.
If IPCS is used, the request is sent using the Session Initiation Protocol 
(SIP) Proxy to the Media Gateway. 

4. The customer’s number is dialed.
If CPA is successful, the call is sent to the voice application that was 
specified by OCS in the outbound dialing request to OBN Manager.
If CPA is unsuccessful, OBN Manager updates the call status and 
sends it to OCS.

Notes: The voice application is specified in Configuration Manager for 
the Outbound Campaign. It will be called for both answered and 
answering machine call results.
CPA is available to the voice application as $cparesult$ in the 
query string and/or VoiceXML session variable.
The User Data sent by OCS to OBN Manager for the outbound 
request is available to the voice application as the $userdata$ 
16 Genesys 7.6



Chapter 1: Overview Proactive Contact Call Flow
VoiceXML session variable. This includes any user-defined 
business data and any mandatory OCS fields.
The Routing Point DN (if configured for the campaign in the Voice 
Transfer Destination field of the Campaign Group object) is 
available to the voice application as the $voice_dn$ VoiceXML 
session variable. This will be used by the voice application as the 
Routing Point DN destination when issuing a RouteRequest 
message if a call requires further processing by a live agent.
GVP uses the OCS Calling Party Number (CPN) received from 
OCS as the Automatic Number Identification (ANI) for outbound 
calls. For information about configuring the CPN, see 
“CPNDigits” on page 45.
In a Proactive Contact solution, unlike in a stand-alone GVP 
solution, CFA does not use the CPA Timeout parameter that is 
provisioned in the EMPS for the outbound IVR Profile, as the 
timeout for calls that are not answered. Instead, the OCS 
call_wait_connected_timeout parameter (in the OCS Campaign 
Group-Level or Application Level options) sets the CPA timeout. 
For more information about setting this OCS option, see 
“call_wait_connected_timeout” on page 45. 

5. The voice application processes the call, directing the IVR interaction with 
the called party.

6. The voice application completes its processing of the call, returning call-
related data to GVP.

7. GVP updates the call status and sends it to OBN Manager.
8. OBN Manager updates the call status and sends it to OCS.

Note: Steps 5 through 8 are repeated each time the voice application 
sends call-related data to GVP.

9. If required, the call can be transferred to an agent for Assisted Service.

Notes: If the voice application determines that the call needs to be 
transferred to an agent, it sends a RouteRequest message to a virtual 
Routing Point (VRP) DN that was specified in the OCS data by 
OCS when the dialing request was sent. This is the same DN that 
was configured as the Voice Transfer Destination DN for the 
Campaign Group that runs in Power GVP mode. The VRP is 
controlled by a URS strategy. The strategy can interact with the 
VoiceXML application in the same way that it interacts during any 
CTI-enabled call between GVP and Framework. When URS has 
finished processing the call, it is transferred to an agent desktop.
A call can also be transferred to an agent by VoiceXML transfer 
without queuing the call first.
Proactive Contact—Solution Guide 17
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10. After the agent processes an Assisted Service call, the call completion 
status is sent to OCS from the agent’s desktop, through T-Server, using the 
outbound desktop protocol.

11. You can choose to have call data sent to GVP Voice Application Reporter 
(VAR). This data includes all outbound contact details, so you can use 
VAR to provide outbound reports.
You can also choose to have OCS data sent to Interaction Concentrator, 
which is the data source for outbound contact details for Genesys Info 
Mart.

For a more detailed description of the messaging underlying a typical call 
flow, see “Detailed Typical Call Flow” on page 60.

Supported Scenarios
The Proactive Contact solution supports the following environmental 
scenarios:
• Single- or multi-tenant environments.
• Any currently supported TDM or IP switches and end points.
• GVP can be configured in either IVR-in-Front or IVR-Behind modes. Any 

available GVP ports can be used for inbound or outbound calls, but some 
ports can be reserved for outbound calling only. In addition, these ports can 
be shared across multiple campaigns. Inbound or outbound ports must be 
configured accordingly in the Element Management Provisioning System 
(EMPS) when they are universal ports (such as in the TDM solution). IPCS 
ports are universal ports by default.

The following figures illustrate the different environments that support the 
Proactive Contact solution:
• GVP Outbound TDM, Carrier Direct (see Figure 2)
• GVP with OCS—TDM/PBX/CTI (see Figure 3 on page 19)
• GVP Direct SIP with IP Call Progress (HMP) (see Figure 4 on page 20)
• GVP IP HMP with OCS and SIP Server (see Figure 5 on page 20)

Note: Figures 2 through 5 provide a general illustration of the associated 
scenario. They do not illustrate all of the connections and components 
included in that scenario.

Figure 2 shows a GVP Outbound TDM environment (Carrier Direct).
18 Genesys 7.6
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Figure 2: GVP Outbound TDM, Carrier Direct

Figure 3 shows GVP with OCS, using TDM/PBX/CTI.

Figure 3: GVP with OCS—TDM/PBX/CTI
Proactive Contact—Solution Guide 19
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Figure 4 shows GVP direct SIP with IP call progress detection using Host 
Media Processing (HMP) software:

Figure 4: GVP Direct SIP with IP Call Progress (HMP)

Figure 5 shows GVP IP HMP with OCS and SIP Server.

Figure 5: GVP IP HMP with OCS and SIP Server
20 Genesys 7.6
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Summary of Solution Configuration Steps
To configure the Proactive Contact solution, do the following:
1. Install and configure Outbound Contact as described in the Outbound 

Contact 7.6 Deployment Guide.
2. Install and configure GVP as described in the Genesys Voice Platform 7.6 

Deployment Guide.
3. Create and configure OBN Manager. For more information, see “Creating 

and Configuring the OBN Manager Application” on page 23.
4. Create or modify the VoiceXML application(s). For more information 

about creating VoiceXML specifications suitable for the Proactive Contact 
solution, see Chapter 4, “Configuring the VoiceXML Application,” on 
page 49.

5. Create or modify the IVR Profile. For more information, see “Provisioning 
the IVR Profile” on page 30.

6. Integrate the GVP VCS with the CPD library. For more information, see 
“Configuring Voice Communication Server” on page 32.

Note: There are no special requirements to integrate IPCS.

For a GVP solution that is configured in behind-the-switch mode, 
additional integration steps are required. For more information, see 
“Configuring Behind-the-Switch Mode” on page 34.

7. Create Campaign Group object(s) to be used for the Proactive Contact 
solution. If your Proactive Contact solution will not use agents, create 
empty Agent Group(s).
For information about the specific configuration requirements for the 
Campaign Group objects, as well as other OCS configuration options that 
affect Proactive Contact solution operations, see Chapter 3, “Configuring 
Outbound Contact,” on page 37.
In particular, ensure that you do the following:
a. Add a connection to the OBN Manager Application to the connections 

of the Campaign Group object (and optionally, for Advanced Disconnect 
Detection Protocol [ADDP] support, to the OCS Application). For 
more information, see “Configuring the Connection Tab” on page 41.

b. Specify the IVR Profile ID in the Advanced tab of the Campaign Group. 
This IVR Profile ID (a string of nine digits) must match the IVR 
Profile ID that EMPS assigned to the VoiceXML application that you 
plan to use for this specific Campaign Group. Alternatively, you can 
specify the IVR Profile ID in the ivr-profile-name option in the OCS 
Application. For more information, see “IVR Profile ID” on page 40.
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Migration
Be aware of the following:
• Outbound Contact 7.5 is compatible with GVP 7.6 at the 7.5 feature level.
• GVP 7.5 is compatible with Outbound Contact 7.6 at the 7.5 feature level.

Note: For more information about migration, see the GVP chapters and 
Outbound Contact chapters in the Genesys 7 Migration Guide. For 
information about interoperability, see the Genesys 7 Interoperability 
Guide.
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2 Configuring Genesys Voice 
Platform
This chapter describes how to configure Genesys Voice Platform (GVP) for a 
Proactive Contact solution. It includes the following sections:

Before You Begin, page 23
Creating and Configuring the OBN Manager Application, page 23
Integrating with Outbound Contact Server, page 30

Before You Begin
This guide assumes that you have successfully installed and configured the 
GVP solution. This document provides information about specific 
configuration requirements to integrate an installed GVP deployment into a 
Proactive Contact solution. For information about installing and configuring 
the GVP solution itself, see the Genesys Voice Platform 7.6 Deployment Guide 
and other resources listed in “Related Resources” on page 7.

Creating and Configuring the OBN 
Manager Application

The key component to integrate the GVP and Outbound Contact solutions is 
the GVP Outbound Notification (OBN) Manager. For more information about 
OBN Manager, see “Outbound Notification Manager” on page 12.
To set up OBN Manager for your Proactive Contact solution, do the following:
1. Create the OBN Manager database, which OBN Manager uses to manage 

requests from the trigger application (see “Configuring the OBN Manager 
Database” on page 24).

2. Create the OBN Manager Application (see “Creating the OBN Manager 
Application” on page 26).
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3. Update the parameters in the GVP Element Management Provisioning 
System (EMPS) (see “Updating EMPS Parameters” on page 26).

4. Identify the Voice Communication Server (VCS) or IP Communication 
Server (IPCS) servers that you want to use for the Outbound application 
(see “Creating IPCS/VCS Server Groups for OBN Manager” on page 29).

Configuring the OBN Manager Database
Create a database with the name obnmanager using your database management 
system (DBMS) tools—Microsoft SQL Server for Windows installations, and 
Oracle for Solaris installations. After you have created the database, you can 
run the database scripts.

Creating the OBN Database Schema

Before you can use OBN Manager, you must run database scripts to create the 
database schema. The following sections describe how to run the scripts:
• For Microsoft SQL Server 2000
• For Microsoft SQL Server 2005 (see page 25)
• For Oracle 10g (see page 25)

For Microsoft SQL Server 2000

1. Open SQL Enterprise Manager.
2. Expand the Microsoft SQL Servers node.
3. Expand the SQL Server group. This now displays a list of servers that it is 

managing.
4. Select your local machine.
5. Expand the Databases node.
6. Right-click Databases and select New Databases.
7. In the Name box, enter obnmanager. Leave the other fields at their default 

values.
8. Click OK. The database now appears in the list on the left pane.
9. From the Tools menu, select SQL Query Analyzer.
10. When the new dialog box opens, select GVP_OBNManager from the 

drop-down list.
11. From the File menu, select Open.
12. Select the <Installation Drive>\GVP\CN\config\database\sqlserver 

folder.
13. Select OBN_DB_NEW_76.sql.
14. Click anywhere inside the script that opens.
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15. From the Query menu, select Execute. After the script has finished running, 
the following message should appear: The command completed 
successfully.

16. Repeat Steps 12–15 for the script OBN_PROC_NEW_76.sql. This script is 
located in the same folder as the previous script.

For Microsoft SQL Server 2005

1. To launch the SQL Server Management Studio, from the Start menu, 
select Programs > Microsoft SQL Server 2005 > Management Studio.

2. Click File > Connect Object Explorer.
3. Enter sa as the User Name and Password.
4. Expand the server name on the Object Explorer.
5. Right-click Databases, and then select New Database.

The New Database dialog box pops up.
6. Enter the Database name.
7. Make changes to the Database files, if required.
8. Click OK.

The database is created.
9. To verify that the database was created, refresh Object Explorer.
10. Select File > Open > File.
11. Use the FileOpen dialog box to select the script <Installation 

Dir>\GVP\Cn\config\database\sqlserver\OBN_DB_NEW_76.sql.
12. Connect as sa when prompted.
13. Change the database in the DB List to the required database.
14. Press F5 to execute the script.
15. Repeat Steps 10–14 for the script OBN_PROC_NEW_76.sql. This script is 

located in the same folder as the previous script.

For Oracle 10g

1. Log in to SQL Plus, and connect with the obnManager user.
2. Execute the scripts contained in the following files. These are located in 

the <CN Dir>/config/database/oracle directory:

Note: The obnManager tablespace and the obnManager user must be created 
before running these scripts.

OBN_DB_NEW_760_oracle.sql
OBN_DB_NEW_OBN_PKG_760_oracle.sql
OBN_DB_NEW_OBN_PKG_BODY_760_oracle.sql
Proactive Contact—Solution Guide 25



Chapter 2: Configuring Genesys Voice Platform Creating and Configuring the OBN Manager Application
Creating the OBN Manager Application
The OBN Manager Application template is distributed with Outbound Contact 
Server (OCS). To create the OBN Manager Application:
1. In Configuration Manager, import the OBN Manager Application 

template.
2. Use the template to create the primary OBN Manager Application.

Configure only the host and port where OBN Manager listens for the OCS 
connection. Ensure that the host and port match the host and port 
configured for OBN Manager in EMPS.

3. If desired, create a separate backup OBN Manager Application, as 
described in Step 2, and specify this backup in the Backup Server field on 
the Server Info tab of the primary OBN Manager Application.

Note: OCS ignores all other properties in the OBN Manager Application 
object.

Updating EMPS Parameters
You must verify or update the parameters for the OBN Manager in the EMPS.
1. In a web browser, access the EMPS login screen by entering the URL 

http://<EMPS-hostname>:9810/spm/login.php.
2. Log in to the EMPS as Admin, and enter the password as admin password.
3. On the EMPS navigation tree, expand the objects Servers > Outbound 

Notification Manager > <ServerName>, and then right-click OBNManager. 
4. From the shortcut menu, select Edit, which opens the Property page.
5. Verify or enter values for the parameters listed in Table 1, and then click 

Save. Restart the WatchDog application on the OBN Manager host after 
you have completed any configuration changes.
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Table 1: OBN Manager Configuration Parameters

Tab Parameter Description Example Values

Advanced 
Configuration

Min DB Pool Size Minimum number of database 
connections kept alive for use in 
QManager.

5

Max DB Pool Size Maximum number of database 
connections kept alive for use in 
QManager.

20

OCS Retransmit 
Timeout

Interval, in seconds, during which 
OBN Manager will try to retransmit 
GVP responses to OCS, if the socket 
connection between OCS and OBN 
Manager has gone down.
OBN Manager regularly scans the 
OBN database to detect responses 
that have not been transmitted to 
OCS. (The interval at which OBN 
Manager scans the database is 
configurable—see the “Retransmit 
Interval” parameter.) For each 
response that has failed to transmit, 
the OCS Retransmit Timeout 
interval starts when the failure first 
occurs and is recorded in the OBN 
database.
If OBN Manager has not succeeded 
in transmitting the response by the 
time that the OCS Retransmit 
Timeout interval expires for that 
response, OBN Manager flushes the 
response from its storage, and does 
not attempt to retransmit it again.

18000

ORP Threads Number of Outbound Request 
Processor (ORP) threads that should 
process requests prepared by 
QManager.

10

Queue Batch Size Number of entries that QManager 
adds to the queue at one time for 
ORP to pick up and process.

200

Clean Interval Interval, in seconds, at which 
QManager removes expired or 
completed requests from the 
database.

300
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Advanced 
Configuration 
(continued)

QCheck Interval Interval, in milliseconds, at which 
QManager removes expired requests 
from the prepared queue, so that 
ORP does not pick up.

3000

Queue Interval Interval, in milliseconds, at which 
QManager populates the internal 
queue.

2000

VCS/IPCS Inactive 
Interval

Interval, in seconds, after OBN 
Manager receives a NO_PORTS 
message in a failure URL from Call 
Flow Assistant (CFA), for which 
OBN Manager will not send any 
requests to the VCS or IPCS that 
sent the message. The applicable 
VCS or IPCS is marked as stale (or 
inactive) for the duration of the 
inactivity interval.
If the applicable VCS or IPCS is the 
only communication server that has 
been configured for OBN Manager, 
requests to the stale server will fail 
and will be treated as failed attempts. 
If the applicable VCS or IPCS is not 
the only communication server that 
has been configured for OBN 
Manager, requests will be sent to the 
other active servers, in round-robin 
fashion.

60

Retransmit Interval Frequency, in seconds, with which 
OBN Manager scans the OBN 
database for failed GVP responses, 
to retransmit to OCS. See also the 
“OCS Retransmit Timeout” 
parameter.

180

Max Active Requests Maximum number of requests that 
are prepared for processing by ORP. 
Genesys recommends that you set 
this to at least five times the size of 
the “Queue Batch Size” parameter.

1000

Table 1: OBN Manager Configuration Parameters (Continued) 

Tab Parameter Description Example Values
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Creating IPCS/VCS Server Groups for OBN Manager
Follow these steps to create IPCS/VCS server groups for Outbound 
applications:
1. On the EMPS navigation tree, right-click Server Groups, and select Add 

New Group.

2. In the Group Name field, enter the name of the group. 
3. From the Server Group Type drop-down list, select OBNCS. 

The Available list in the Servers Selection section is populated with all 
of the IPCS and VCS servers that have been provisioned.

4. For each IPCS or VCS server that you want to use as an Outbound 
Application, click the server in the Available list, and then click >> to 
move it to the Selection list.

For VCS, ensure that you select only servers that have provisioned 
Outbound ports (the Route Type of the Route1 node has been set to 
either Inbound & Outbound or Outbound)
For IPCS, you can select any server, because the ports are universal.

OCS 
Configuration

OCS Configured Select this check box for OCS-OBN 
integration.

Selected

OCS Listener Port Port used to establish a connection 
with OCS. The port is set to 2355.

2355

Data Store Database Server 
Name (Oracle Net 
Service Name in case 
of Oracle)

Name of the database server 
machine.

Oracle: 
GENGRP_172.24.129.52

Microsoft SQL:
172.24.129.52

Database Username Username for database user account. obnmanager

Database Password Password for database user account. obnmanager

Database Catalog
Note: There is no 
database catalog for 
Solaris hosts, and 
therefore this 
parameter will not be 
displayed.

Name of the database instance on 
which OBN Manager data is stored.

OBN_MT

System Log Levels Control the amount of information 
that is written to the log file.

*:0x3

Table 1: OBN Manager Configuration Parameters (Continued) 

Tab Parameter Description Example Values
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To remove a server from the Selection list, click the server, and then click 
<<.

5. Click Save.

Integrating with Outbound Contact Server
To enable the Proactive Contact solution, you must perform the following 
steps to integrate GVP with OCS:
• Configure the IVR profile to provision the voice application (see 

“Provisioning the IVR Profile”).
• Integrate the GVP VCS with the Call Progress Detection (CPD) library 

(see “Configuring Voice Communication Server” on page 32).

Note: There are no special configuration requirements for the IPCS.

• For a GVP solution that is configured in behind-the-switch mode:
Modify the parameter (PrependHostIPToCalledNum) that controls what 
information is sent from the IVR Server Client to the IVR Server in a 
New Call request.
Ensure that the port range of the VCS matches the corresponding range 
of the Voice Treatment Ports defined in the Configuration Layer.

For more information, see “Configuring Behind-the-Switch Mode” on 
page 34.

Provisioning the IVR Profile
To use Outbound Notification, you must create and provision an IVR profile in 
the EMPS. This provisions the VoiceXML application that will be used in the 
outbound campaigns.
For general information about creating or modifying an IVR Profile, see the 
section about IVR Profiles in the Genesys Voice Platform 7.6 Reference 
Manual. This guide provides information about configuring the OBN Property 
page only.

Note: On the IVR Profile Main page, ensure that the Application Type is 
Outbound.

Figure 6 shows the OBN Property Page.
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Figure 6: Provision IVR Profile—OBN Property Page

1. Select the Enable OBN check box.

Note: You can select this check box only if you selected Outbound as the 
IVR profile type when you created the IVR profile.

2. Enter the Failure URL that the OBN Manager calls if a call is not placed for 
any reason. If the trigger request contains a value for the failure_url 
parameter, that URL is used instead of this one. However, if a failure URL 
is not specified as part of the trigger request, this URL is used by OBN 
Manager for requests of this IVR profile.

3. In the Max Queue Size field, enter the maximum number of unprocessed 
requests that OBN Manager queues for this IVR profile at any given time. 
The number that you enter should be large enough to accommodate the 
expected number of requests from the trigger IVR profile.

4. The OBN Servers box lists all OBN Manager machines. From this list, 
select the machines on which you want to process requests for this IVR 
profile. You must select at least one machine, but there is no upper limit to 
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the number of machines that you can select. If you want to prevent an OBN 
Manager machine from processing this IVR profile’s requests, do not 
select that machine.

5. The OBN Groups lists all groups of the type OBNCS. (These are the groups 
you created as described in “Creating IPCS/VCS Server Groups for OBN 
Manager” on page 29.) From this list, select one or more groups. The OBN 
Manager machines that you selected in the previous step will use VCS/
IPCS machines that are members of these groups to make calls for this 
IVR profile.

6. Select the OCS Flag check box if you want OBN Manager to accept 
outbound call requests from OCS for this this IVR profile.

7. Enter a value, in seconds, in the AfterConnect Timeout field. This timeout 
is set when the IVR profile (voice application) needs to detect an 
answering machine or fax. If this timeout is set, after the outbound call is 
answered, it will wait for specified afterconnecttimeout seconds to detect 
a fax or answering machine.

8. Click Save to save the profile.

Configuring Voice Communication Server
For Proactive Contact support, GVP VCS has been integrated with the CPD 
library to provide for superior Call Progress Analysis (CPA) detection through 
the combination of T-Server and Dialogic technology. To enable CPD, you 
must configure the server parameters in EMPS as shown in Table 2.

Notes: When the VCS is behind a Nortel Symposium switch, and the VCS has 
been configured to use the CPD library for outbound calls, you must 
set these two parameters as follows in order for the calls to go through:
• CPD Off-hook Delay: -500
• CPD Calls Cleared by TServer: selected

When the VCS is behind a Nortel Symposium switch, and the CPD 
library is enabled to make outbound calls, the AutoLogin option in the 
Symposium should be turned off. If the AutoLogin option is turned on, 
the switch provides a special dialtone instead of the regular dialtone. 
The VCS will not recognize this special dialtone and will not start 
dialing after offhook.
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Table 2: Call Progress Detection Parameters

Location of 
Parameter

Parameter Description

Servers > VCS > 
PopGateway > Route 
node

Enable Genesys CPD 
Library

Check box that specifies whether outgoing calls 
are to be made using the Genesys CPD library.

Servers > VCS > 
PopGateway > Route 
node

Range of Directory 
Numbers

Specifies the directory number range for the 
route. Specify directory numbers that are 
separated by a dash or commas—for example: 
101-110, 115, 120-130

Servers > VCS > 
PopGateway > CPD 
node

IP Address of Primary 
TServer

Specifies the IP address of the primary T-Server.

Servers > VCS > 
PopGateway > CPD 
node

Primary TServer 
Listening Port

Specifies the port for the primary T-Server.

Servers > VCS > 
PopGateway > CPD 
node

IP Address of Backup 
TServer

Specifies the IP address of the backup T-Server.

Servers > VCS > 
PopGateway > CPD 
node

Backup TServer 
Listening Port

Specifies the port for the backup T-Server.

Servers > VCS > 
PopGateway > CPD 
node

CPD Calls Made by 
TServer

Specifies whether outgoing calls are to be made 
by T-Server.

Servers > VCS > 
PopGateway > CPD 
node

CPD Calls Cleared by 
TServer

Specifies whether outgoing calls are to be cleared 
by T-Server.

Servers > VCS > 
PopGateway > CPD 
node

CPD Off-hook Delay This parameter is used only if the parameter CPD 
Calls Made by TServer is selected. 
Specifies the off-hook delay in milliseconds. A 
negative value specifies to go off-hook first, wait 
for the specified time, and then dial a number. A 
positive value specifies to dial first, wait for the 
specified time, and then set the channel off-hook.
Default value: 0
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Configuring Behind-the-Switch Mode
If your GVP solution is configured in behind-the-switch mode, the following 
additional steps are required:
1. In EMPS, expand Servers > GQA > <server host name>, and then click on 

the <customer process name> node.
2. Click Edit Node.
3. Click Add New Attribute.
4. Enter the following values in the text boxes that appear: 

Parameter Name: PrependHostIPToCalledNum

Parameter Value: 0

This parameter removes an IP address from the New Call request that the 
IVR Server Client sends to the IVR Server.

5. Click Save.

Servers > VCS > 
PopGateway > CPD 
node

For CPD, go Off-hook 
Before Dial

This parameter is used only if the parameter CPD 
Offhook Delay has a negative value. 
If this parameter is selected, the CPD library 
waits for the off-hook confirmation event from 
T-Server before dialing.

Servers > VCS > 
PopGateway > CPD 
node

CPD Preconnect Specifies whether priority should be given to 
either T-Server or Dialogic in the event of 
conflicting CPD results. Values are:
• TServer

• Dialogic

Servers > VCS > 
PopGateway > CPD 
node

CPD Postconnect 
Priority

Specifies whether priority should be given to 
T-Server or Dialogic in the event of conflicting 
CPD results. Values are:
• TServer

• Dialogic

Servers > VCS > 
PopGateway > CPD 
node

For CPD, FAX2 Tone as 
Ans Machine

Check box that specifies whether the CPD library 
should accept the FAX2 tone as answering 
machine.

Servers > VCS > 
PopGateway > CPD 
node

CPD Reconnect 
Timeout for TServer

Specifies the dialer’s reconnect timeout for 
T-Server in milliseconds.
Default: 20000

Table 2: Call Progress Detection Parameters (Continued) 

Location of 
Parameter

Parameter Description
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You must also ensure that the port range of the VCS matches the 
corresponding range of the Voice Treatment Ports defined in the Configuration 
Layer. The Voice Treatment Port range must be contiguous (for example, 
001-023).
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3 Configuring Outbound 
Contact
This chapter describes how to configure Outbound Contact for a Proactive 
Contact solution. It includes the following sections:

Before You Begin, page 37
Configuring a Campaign Group, page 37
Configuration Options, page 43
Enabling Historical Reporting for Genesys Info Mart, page 47

Before You Begin
This guide assumes that you have successfully installed and configured the 
Outbound Contact solution. This document provides information about 
specific configuration requirements to integrate an installed Outbound Contact 
deployment into a Proactive Contact solution. For information about installing 
and configuring the Outbound Contact solution itself, see the Outbound 
Contact 7.6 Deployment Guide and other resources listed in “Related 
Resources” on page 7.

Configuring a Campaign Group
A Campaign Group is the main configuration object in Outbound Contact. It can 
be found as a subfolder within the Campaign object in Configuration Manager. 
The Campaign Group is defined as a Campaign (a set of calling lists) that is 
assigned to work resources such as an Agent Group or a Place Group.
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Note: To be able to create a Campaign Group, you must have one or more 
Agent Groups or Place Groups. If there are no agents who will handle 
Genesys Voice Platform (GVP) outbound calls, so that all calls are 
processed by voice application(s) only, Genesys recommends that you 
create an empty Agent Group or Place Group, so that you can create a 
Campaign Group.

The following sections describe how to configure a Campaign Group for the 
Proactive Contact solution:
• “Configuring the General Tab”
• “Configuring the Advanced Tab” on page 39
• “Configuring the Connection Tab” on page 41
• “Configuring the Annex Tab” on page 43
See also “Configuration Options” on page 43 for additional Outbound Contact 
Server (OCS) configuration options related to Campaign Groups that are 
relevant for the Proactive Contact solution.

Configuring the General Tab
Table 3 describes the parameter settings that you must configure on the 
General tab of the Campaign Group object.

Table 3: General Tab Parameters

Parameter Comment

Name The name of the Campaign Group. The format is 
[<Campaign name>@<Agent Group name or Place Group 
name>]. This name must be unique within the tenant. 
The name is automatically populated by the system.

Tenant Automatically populated by the system.

Campaign The name of the campaign that is used to form the Name 
field.

Group The name of the group that is used to form the Name 
field.

Group Type The type of group (agent or place).
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Configuring the Advanced Tab
Table 4 describes the parameter settings that you must configure on the 
Advanced tab of the Campaign Group object.

Description Optional: default is [Blank].
A brief description of the campaign group.

State Enabled Required: default is [on]. 
A check box that indicates that this campaign group is 
active and can be loaded and started by OCS. For more 
information, see Framework 7.6 Configuration 
Manager Help.

Table 3: General Tab Parameters (Continued) 

Parameter Comment

Table 4: Advanced Tab Parameters

Parameter Comment

Dialing Mode Choose Power GVP.

Voice Transfer 
Destination

The DN to which calls are to be delivered for handling by 
live agents.
Note: In addition to the Voice Transfer Destination 
DN, any ACD Queue, Virtual Queue, Routing Point, or 
Service Number DN that may be part of a call flow 
involving this group of agents or places must be specified 
as an Origination DN in the Advanced tab of the Agent 
Group or Place Group objects in Configuration Manager. 
OCS needs to monitor these DNs to identify “foreign” 
inbound or outbound calls that are delivered to agents but 
were not issued by OCS on behalf of the Campaign Group, 
or if the ACD Queue DN is configured as an “overflow” 
DN.
To avoid incorrect results with the dialing algorithm, do 
not configure the same DN as an Origination DN for 
more than one Agent Group or Place Group that is part of 
a predictive or progressive dialing mode campaign.

Operation Mode Not applicable to the Proactive Contact solution.

Optimization 
Method

Not applicable to the Proactive Contact solution.

Target Value Not applicable to the Proactive Contact solution.
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Max Queue Size Determines the number of records to keep in OBN 
Manager’s queue. It is an internal counter that is used 
when OCS performs with the Power GVP mode. OCS tries 
to always keep dialer’s buffer full with the specified Max 
Queue Size, subject only to a record’s availability in the 
calling list. See also Buffer Size Coefficient.

IVR Profile ID The nine-digit IVR Profile ID that is specified in the GVP 
Element Management Provisioning System (EMPS), IVR 
Profile. An ID is created automatically in EMPS when the 
IVR profile is created. In EMPS, when you select Edit on 
the IVR Profile, the ID is visible in the User Interface as 
the first parameter, and is labelled as Application ID.

In order for OCS to supply OBN Manager with Voice 
Application ID in Request OBNRecordStartDial, OCS 
derives this ID from the value of the ivr-profile-name 
option. If you created different IVR Profiles (Voice 
Applications) to be used by different Campaign Groups 
on different Outbound Campaigns, specify the nine-digit 
IVR Profile ID in the IVR Profile ID field of the 
Campaign Group Advanced tab. In this case, a section 
named OCServer that contains the ivr-profile-name 
option is created automatically by Configuration Manager 
in the Annex tab of the Campaign Group object.
Alternatively, if you intend to use the same Voice 
Application for all campaigns, you can configure this 
option manually in the Options tab of the OCS 
Application object. In this case, you can leave the IVR 
Profile ID field on the Advanced tab of the Campaign 
Group object empty.

Interaction Queue Not applicable to the Proactive Contact solution.

Script Defines the Script object that contains all of the 
attributes that are required by Agent Scripting. See the 
“Attaching Script Information to OCS User Event and 
Telephony Events” in Chapter 2 of the Outbound Contact 
7.6 Reference Manual.

Table 4: Advanced Tab Parameters (Continued) 

Parameter Comment
40 Genesys 7.6



Chapter 3: Configuring Outbound Contact Configuring a Campaign Group
Configuring the Connection Tab
The Connection tab enables you to specify all server connections (besides 
T-Server) that are required to run an outbound campaign in a certain dialing 
mode for a particular campaign group. For the Power GVP dialing mode, the 
GVP OBN Manager Application and a Stat Server Application must be 
specified in the Connection tab of the Campaign Group configuration object in 
order to enable GVP integration.

Buffer Size 
Coefficient

For the Power GVP dialing mode, both the minimum and 
the optimum buffer size coefficients are set as a 
percentage of the desired Max Queue Size value. For 
example, if the minimum = 100, optimum = 150, and Max 
Queue Size = 200, OCS will keep 300 chains in its 
buffer for the given Campaign Group, and then fetch 
more records when the buffer size falls to fewer than 
200 chains.

Number of CPD 
Ports

Not applicable to the Proactive Contact solution.

Table 4: Advanced Tab Parameters (Continued) 

Parameter Comment
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Figure 7 shows an example of the Connection tab.

Figure 7: The Campaign Group Connection Tab

When configured to enable OCS connections, the GVP OBN Manager opens a 
predefined port (for listening purposes) and then accepts requests from an OCS 
application on this port. For information about configuring OBN Manager, see 
“Creating and Configuring the OBN Manager Application” on page 23.

Notes: If you configured a backup OBN Manager in the Server Info tab of 
the primary OBN Manager Application, add only the primary OBN 
Manager Application to the Campaign Group connections and 
(optionally) to the OCS Application connections.
The Campaign Group connection provides basic host/port connectivity 
only. It does not provide features such as Advanced Disconnect 
Detection Protocol (ADDP). You can also add your OBN Manager 
Application to the Connection tab of the OCS Application object in 
order to configure any additional connection parameters (such as 
ADDP).
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Configuring the Annex Tab 
Use this tab to define options related to the Outbound Campaign Group. An 
option defined in this tab fine-tunes the system on the individual campaign 
group level.

Configuration Options
The following OCS configuration options are either required or else 
particularly useful for the Proactive Contact solution:
• Campaign Group-Level options
• Calling List options (see page 46)

Campaign Group–Level Options

Configure the Campaign Group–Level options on the Options tab of the OCS 
Application or on the Annex tab of the Campaign Group.

Required The following Campaign Group–Level options are required:

dialer-ttl
Type: Optional
Default Value: 5
Valid Values: 3–1440
Specifies the Time To Live (in minutes) during which OBN Manager will 
attempt to pass a request to the GVP dialer (IP Communication Server [IPCS] 
or Voice Communication Server [VCS]) for a dial from its internal dialing 
queue. 

dialer-num-attempts
Type: Optional
Default Value: 3
Valid Values: 1–25
Specifies the number of times that OBN Manager will attempt to pass a request 
to the GVP dialer (IPCS or VCS) for a dial from its internal dialing queue.

Note: Both of the above options are used with OBN Manager in Power GVP 
dial mode only.
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Optional The following Campaign Group–Level options significantly affect the 
performance of proactive contact campaigns:

dialing_rate_limit
Type: Optional
Default Value: 100
Valid Values: 0–N
Specifies the maximum number of dialing requests per second. If the option is 
set to 0 (zero), then OCS does not dial at all. Use this option to adjust the speed 
of sending dialing requests from OCS to OBN Manager, especially when 
dialing has just been started and the Max Queue Size is significant.

call_answer_type_recognition
Type: Optional
Default Value: no_am_detection
Valid Values: no_progress_detection, no_am_detection, 
positive_am_detection, full_positive_am_detection, 

accurate_am_detection, diversion_am_detection

Specifies whether answering machine and fax detection are enabled or 
disabled. This option applies only when OCS uses CPD Server. It does not 
apply when OCS uses PBX equipment for call progress detection.
• no_progress_detection disables CPD, and the call is transferred as soon as 

it is established.
• no_am_detection disables answering machine detection, but detection of all 

other devices is still enabled.
• positive_am_detection enables standard answering machine detection 

(Positive Answering Machine [PAM] mode).
• full_positive_am_detection enables full positive answering machine 

detection (Full Positive Answering Machine [FPAM] mode).
• accurate_am_detection enables or disables detection, based on an analysis 

of the duration of the greeting.

Note: For Proactive Contact only, this option applies only when the GVP 
dialer (VCS/IPCS) uses the CPD Library.

call_timeguard_timeout 
Type: Optional
Default Value: 0 (milliseconds)
Valid Value(s): 0...<N> (milliseconds) 
Enables a user to set a timeout interval for post-connect call progress detection. 
The call is transferred to a queue when the timeout expires, regardless of the 
call result or the completion of call progress detection. The timeout is 
calculated from the moment that CPD Server receives an EventEstablished 
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message. If this option is set to 0 (zero) or if it is not present, CPD Server 
does not break call progress detection.
This option applies only when OCS uses CPD Server. It does not apply when 
OCS uses PBX equipment for call progress detection.

CPNDigits
Type: Optional
Default Value: Empty string
Valid Value(s): String of characters, according to the formats specified in the 
appropriate numbering/dialing plan.
Specifies the Calling Party Number (CPN). It enables OCS to pass the ANI to 
OBN Manager when it is using the Power GVP dialing mode.
For more information about the Caller ID Support feature and the CPN 
options, see:
• Extensions related to TMakePredictiveCall() in the “Extensions” section of 

the “Unstructured Data” chapter in the Genesys Developer Program 
TLibrary SDK Developer's Guide, 7.6

• Framework 7.6 T-Server for Alcatel A4400/OXE Deployment Guide
• Framework 7.6 T-Server for Avaya Communication Manager Deployment 

Guide
• Q.931 ISDN user-network interface layer 3 specification for basic call 

control

Note: This option is new for Proactive Contact 7.6 but not new for Outbound 
Contact Server.

call_wait_connected_timeout
Type: Optional
Default Value: 120 (seconds)
Valid Value(s): 0–7200 (seconds)
• For ISDN: Specifies the timeout, in seconds, between dialing and the 

determination that the called party is not answering.
• For analog and line-side DNs: Specifies the timeout, in seconds, between 

the first ring and the determination that the called party is not answering.
When the called party is not answering, this option value overrides of the OBN 
Timeout value, which is set in the IVR tab of the OBN Application object.

Note: In the Proactive Contact solution, the value of the OCS 
call_wait_connected_timeout option is used by the GVP Call Flow 
Assistant (CFA) as the Call Progress Analysis (CPA) timeout for calls 
that are not answered.
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stale_clean_timeout
Type: Optional 
Default Value: 30
Valid Value(s): Any positive integer
Specifies the timeout (in minutes) before OCS marks any records that remain 
in the buffer as Stale. Such records may have been sent for processing, but 
were not processed.

Note: The time OCS requires to process all of the dialing requests sent to 
OBN Manager may be longer than the default value of 30 minutes, 
depending on the number of such requests (defined by the Max Queue 
Size parameter on Advanced tab of Campaign Group configuration 
object). Therefore, Genesys recommends that you configure this option 
with a value higher than the default so that OCS does not mark those 
records as stale in a calling list before GVP is able to process them.

Calling List–Level Options

You can configure the Calling List–level options on the Options tab of the 
OCS Application, or you can store them at the Calling List level.

Note: You can also configure treatments that define how OCS reacts to 
unsuccessful dial attempts for each calling list. Configure these 
treatments in the Treatments tab of the Calling List configuration 
object.

Optional The following Calling List–level option significantly affects the performance 
of proactive contact campaigns:

am-detection-map
Type: Optional
Default Value: NULL
Valid Values: Any name of a Business Attribute value configuration object, 
or default
Specifies the name of the Business Attribute value configuration object that 
contains the Answering Machine (AM)–detection map to be used for a 
particular Calling List or to be used application-wide.
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Enabling Historical Reporting for Genesys 
Info Mart

OCS passes an outbound call’s GUID, received from OBN Manager, to 
Interaction Concentrator, which is the source of OCS data for Genesys 
Info Mart.
The following requirements and limitations apply for Outbound Contact 7.6 
historical reporting, when using Interaction Concentrator:
• To enable reporting on all activity for a specific Campaign Group, 

including chain activities:
You must specify a valid Voice Transfer Destination DN in the 
configuration properties of the Campaign Group. 
The Voice Transfer Destination DN must be located on the switch 
that is served by the T-Server to which OCS is currently connected.
T-Server must be running and must have a CTI link with the switch.

• In the following scenarios, OCS is not able to obtain CallGUID information 
when the Campaign Group is running in Power GVP mode:

The connection between I-Server Client and I-Server is broken.
I-Server Client is not configured correctly, neither in GVP nor in 
Framework.
The connection between I-Server and T-Server is broken.
The connection between T-Server and the switch is broken.
There is no T-Server in the deployment.
Chain-related events for these types of calls do not contain the unique 
identifier (Call GUID) of the outbound call(s) dialed during chain 
processing. As a result, Interaction Concentrator does not receive the 
information it needs to create records in its database.
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4 Configuring the VoiceXML 
Application
Proactive Contact solution outbound calls are processed by custom voice 
applications that are written in standard Voice Extensible Markup Language 
(VoiceXML) 2.1. Genesys provides an optional tool, Studio, to assist you in 
developing voice applications for Genesys Voice Platform (GVP).
This chapter provides information about VoiceXML building blocks that are 
particularly relevant for Proactive Contact solution applications. It includes the 
following sections:

User Data, page 49
VoiceXML Application Variables, page 50
Genesys Voice Platform Studio, page 54

For more information about developing VoiceXML applications for GVP, see 
the Genesys Voice Platform 7.6 VoiceXML 2.1 Reference Manual.

User Data
This section describes how user data is passed between Outbound Contact 
Server (OCS) and the VoiceXML application.

User Data from OCS

User data from OCS is made available to the voice application through 
$variables. User data is passed as key-value pairs (KVPs) from OCS. The GVP 
Call Flow Assistant (CFA) passes the KVPs to the PopGateway in <DIAL_CALL> 
as $variables. All $variables that are passed from CFA are, in turn, made 
available to the voice application.
If the key of a key-value pair of the user_data is <token>, then $<token>$ is 
used by the voice application to access the value.
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User Data to OCS

The voice application can post user data back to OCS by using the 
VoiceXML 2.1 <data> tag. The URL is provided by OCS through $obn_url$.

VoiceXML Application Variables
This section provides information for users who write stand-alone VoiceXML 
applications (not using Studio) for the Proactive Contact solution. It describes 
the set of OCS keys that form the user data between OCS and the VoiceXML 
application.

Note: If you are using Studio, see page 54.

The following variables are used in the VoiceXML application:
• OCS Flag Variable
• CPA Result Variable
• UserData from OCS (see page 51)
• Call Result User Data (see page 52)
• User Data for Schedule Call Back or Campaign Reschedule (see page 52)
• Customized User Data to OCS from the Voice Application (see page 54)

OCS Flag Variable
The voice application checks for the OCS flag in the arrived data from OCS. If 
this flag is set to 0, the voice application stops the data processing. Otherwise, 
it processes the rest of the data.

Example

<var name="OCSApplicationFlag" expr="session.genesys.OCSFlag" />

This will be used as follows:

<if cond="session.genesys.OCSflag == 0">
  <throw event="Throw your error" message="Not configured as an outbound application" />
</if>

CPA Result Variable
The session.genesys._cparesult variable branches out the voice application 
logic. The voice application checks for the values CPA_NORMAL and 
CPA_ANSWERMACHINE for this variable. The other values received by the voice 
application for this variable are CPA_BUSY, CPA_NOANSWER, and so on, but the 
voice application can ignore these values.
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Example

<var name="CPAResult" expr="session.genesys._cparesult" />

<block>
<if cond=" OCSApplicationFlag == 1 and 
                CPAResult == 'CPA_NORMAL'">
<var name="user_data" expr="'GSW_CALL_RESULT=0'" /> 
<data method="post" namelist="user_data" srcexpr="session.genesys.obn_url" /> 
</if>

<if cond=" OCSApplicationFlag == 1 and 
                OCSCPAResult == 'CPA_ANSWER_MACHINE'">
<var name="user_data" expr="'GSW_CALL_RESULT=9'" /> 
<data method="post" namelist="user_data" srcexpr="session.genesys.obn_url" /> 
</if>
</block>

UserData from OCS
The session.genesys.User_Data variable receives the posted OCS User Data.

Example

<var name="OCSUserData" expr="session.genesys.User_Data" />

The OCS user data looks like the following:

GSW_TZ_OFFSET=-28800&GSW_PHONE=6504664689&BusinessStringData1=Hello 
World&BusinessIntegerData1=12345&GSW_CALLING_LIST=obn_call_list&GSW_CAMPAIGN_NAME=ob
n_campaign&GSW_CONTACT_MEDIA_TYPE=voice&GSW_RECORD_HANDLE=178&GSW_APPLICATION_ID=106
&GSW_CALL_ATTEMPT_GUID=C6083O88F3BK5F50LPDM6I70EC00002P&GSW_CAMPAIGN_GROUP_DBID=101&
GSW_CAMPAIGN_GROUP_NAME=obn_campaign@OBN Agent 
Group&GSW_CAMPAIGN_GROUP_DESCRIPTION=&GSW_CALLING_LIST_DBID=101&GSW_CHAIN_ID=3&GSW_S
WITCH_DBID=0&GSW_ATTEMPTS=33&GSW_CALL_RESULT=1&InteractionType=Outbound&InteractionS
ubtype=OutboundNew

The voice application usually receives the OCS keys in key-value form in the 
user data from OCS. Table 5 lists some of the user data attributes that are 
available from OCS.

Note: The OCS key names in Table 5 are the default keys that are specified in 
Studio as User Data attributes for the get operation.

Table 5: OCS User Data Attributes

OCS Key Name Data Type Description

GSW_ATTEMPTS Integer Number of attempts made to this target DN.

GSW_CALLING_LIST String Name of the outbound calling list.
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Call Result User Data
The OCS key GSW_CALL_RESULT sends the call result back to OCS. Sample 
values are as follows:
GSW_CALL_RESULT = 51 > Don't call Record Action
GSW_CALL_RESULT = 52 > Cancel Record Action
GSW_CALL_RESULT = 33 > Answer

The GSW_CALL_RESULT is part of user_data, and it is sent in HTTP Post from the 
voice application. The following is sample code:

<var name="user_data" expr="'GSW_CALL_RESULT=3'" /> 
       <data name="PutOCSUserData" method="post" namelist="user_data" 

srcexpr="session.genesys.obn_url" /> 

User Data for Schedule Call Back or Campaign Reschedule
The OCS keys GSW_PHONE, GSW_DATE_TIME, and GSW_TZ_TIME are used in 
conjunction with each other for rescheduling.
• GSW_PHONE—Used for the outbound dialed DN. This key is part of the user 

data from either OCS or the voice application. It is a string data type.
• GSW_DATE_TIME—Used to reschedule the call. This key is part of the user 

data, and it is present in the response from the voice application to OCS. It 
is a string data type in MM/DD/YYYY HH:MM format, where HH is 00-23.

• GSW_TZ_NAME—Represents the time zone. This key is part of the user data 
from the voice application to OCS. It exists in the user data whenever 
GSW_DATE_TIME exists in the user data from the voice application to OCS. It 
is a string data type. The values for this are various time zones such as PST, 
CST, EST, and so on.

• GSW_CAMPAIGN_NAME and GSW_CALLING_LIST—Represent the active campaign 
name and the calling list name from which the user data has arrived to the 
voice application from OCS. The voice application has the capability to 
reschedule the call at different active campaign calling lists. Therefore, 
when the voice application needs to reschedule the call at a different phone 

GSW_CAMPAIGN_NAME String Name of the Outbound campaign.

GSW_PHONE String Outbound dialed DN.

GSW_TZ_OFFSET Integer Time offset between GMT and the dialed DN’s time 
zone.

GSW_RECORD_HANDLE Integer Unique identifier of the calling list record.

Table 5: OCS User Data Attributes (Continued) 

OCS Key Name Data Type Description
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number than the number that it received from OCS, it must also send the 
valid active campaign name and calling list name using these keys. The 
values for these keys can be the same values that the voice application has 
received in the user data from OCS or new valid values.

The voice application handles the Campaign Rescheduling or Scheduled Call 
Back in four different ways:

Reschedule at
Same Phone

Number (1)

• The voice application can use the same GSW_PHONE value that it received in 
the user data from OCS, and build the new user data with GSW_PHONE, 
GSW_DATE_TIME, and GSW_TZ_NAME. As a result, OCS reschedules the call on 
the same phone number at a different time. 
The following is sample code:

<var name="user_data" expr="'GSW_DATE_TIME=01/01/2007   
10:20&GSW_PHONE=408xxxyyyy&GSW_TZ_NAME=PST'" /> 

  <data name="PutOCSUserData" method="post" namelist="user_data" 
srcexpr="session.genesys.obn_url" />

Reschedule at
Same Phone

Number (2)

• The voice application can set the no value for the GSW_PHONE value. In such 
a case, OCS uses the same value that it sent out in its user data. The voice 
application builds the new user data with GSW_PHONE (no value is set), 
GSW_DATE_TIME, and GSW_TZ_NAME. As a result, OCS reschedules the call on 
the same phone number at a different time.
The following is sample code:

<var name="user_data" expr="'GSW_DATE_TIME=01/01/2007   
10:20&GSW_PHONE=&GSW_TZ_NAME=PST'" /> <data name="PutOCSUserData" method="post" 
namelist="user_data" srcexpr="session.genesys.obn_url" /> 

Reschedule at
Same Phone

Number (3)

• The voice application can remove the GSW_PHONE key from its response to 
OCS. The voice application builds the new user data with GSW_DATE_TIME, 
and GSW_TZ_NAME. As a result, OCS reschedules the call on the same phone 
number at a different time.
The following is sample code:

<var name="user_data" expr="'GSW_DATE_TIME=01/01/2007   10:20&GSW_TZ_NAME=PST'" /> 
<data name="PutOCSUserData" method="post" namelist="user_data" 
srcexpr="session.genesys.obn_url" /> 

Reschedule at
Different Phone

Number

• The voice application can modify the GSW_PHONE value that it received in 
the user data from OCS, and build the new user data with GSW_PHONE, 
GSW_DATE_TIME, and GSW_TZ_NAME. As a result, OCS reschedules the call at a 
different phone number at a different time. OCS adds a new record in its 
calling list.
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The following is sample code:

<var name="user_data" expr="'GSW_DATE_TIME=01/01/2007   
10:20&GSW_PHONE=650xxxyyyy&GSW_TZ_NAME=PST& 
GSW_CAMPAIGN_NAME=Campaign1&GSW_CALLING_LIST=CallingList1'" /> 

  <data name="PutOCSUserData" method="post" namelist="user_data" 
srcexpr="session.genesys.obn_url" /> 

Customized User Data to OCS from the Voice Application
The voice application can update the customized user data from OCS, and send 
it back to OCS by using the HTTP Post method.
The following code shows how to send the user data back to OCS. The keys 
BusinessString1 and BusinessintegerData1 are customized keys between OCS 
and the voice application; they are not predefined keys.

<var name="user_data" expr="'BusinessStringData1=Hello 
World&BusinessIntegerData1=12345'" /> 

       <data name="PutOCSUserData" method="post" namelist="user_data" 
srcexpr="session.genesys.obn_url" />

Genesys Voice Platform Studio
Genesys Voice Platform Studio is a graphical user interface (GUI) for the 
development of voice applications using VoiceXML.
Studio provides the following new features for the Proactive Contact solution:
• Block for getting and setting OCS data
• Exceptions and global variables in the Studio Start and subcall flow blocks
• Support for Do Not Call information
For more information, see the Genesys Studio Help file.
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Figure 8 shows the OCS Data tab to get information.

Figure 8: New OCS Data Block—Get

To specify a User Data attribute for the get operation:
1. On the OCSData tab, in the Operation section, select the Get check box.
2. Click Add.

The OCS Data Item dialog box displays.
3. Type the name of the key into the OCS Key Name drop-down box, or select 

one of the predefined keys.
4. Click OK.

The attribute is added to the OCS Key Name list on the OCSData tab.
The OCS key names that are shown in Figure 8 are the default User Data 
attributes that are available for the get operation. For descriptions of the 
default attributes, see Table 5 on page 51.
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Figure 9 shows the OCS Data tab to send information back to OCS.

Figure 9: New OCS Data Block—Put

To specify a User Data attribute for the put operation:
1. On the OCSData tab, in the Operation section, select the Put check box.
2. Click Add.

The OCS Data Item dialog box displays.
3. Type the name of the key into the OCS Key Name drop-down box, or select 

one of the predefined keys. Similarly specify applicable values for the key 
in the Value box.

4. Click OK.
The attribute is added to the OCS Key Name list on the OCSData tab.
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Table 6 lists the default User Data attributes for the put operation.

Figure 10 shows the default call result attributes that are available in Studio.

Figure 10: Sending Call Result Data Back to OCS

Table 6: OCS User Data Attributes—Send

OCS Key Name Data Type Description

GSW_CALL_RESULT Integer 
(0–53)

End result of the current outbound dialed call.
For sample values, see “Call Result User Data” on 
page 52. For the full list of possible call results, see 
the Outbound Contact 7.6 Reference Manual. For 
the default value options that Studio presents for 
selection, see Figure 10.
Note: The GSW_CALL_RESULT is automatically set in 
the START block so that it corresponds to the 
OCSCPAResult value.

GSW_DATE_TIME String
(MM/DD/
YYYY 
HH:MM)

Date and time of the scheduled call back.

GSW_PHONE String Outbound dialed DN.

GSW_TZ_NAME String Current time zone of the call.
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5 Proactive Contact Solution 
Reference Information
This chapter provides reference information about the Proactive Contact 
Solution. It includes the following sections:

Framework Port, page 59
Power GVP Dialing Mode, page 59
Detailed Typical Call Flow, page 60
OBN Error Codes, page 63

Framework Port
For the Proactive Contact solution, the Voice Communication Server (VCS)/IP 
Communication Server (IPCS) passes to Call Flow Assistant (CFA) the 
Framework port number of the channel used for the outbound call. This 
enables the Voice Extensible Markup Language (VoiceXML) application to 
interface with Framework as it does with inbound calls. For more information, 
see the Genesys Voice Platform 7.6 VoiceXML 2.1 Reference Manual.

Power GVP Dialing Mode
A proactive contact campaign operates in Power GVP mode.
The following sections describe how calling records are dialed:
• “Dialing Algorithm” on page 60
• “Calculating the Number of Records” on page 60
• “Do Not Call Records” on page 60
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Dialing Algorithm

In a Genesys Voice Platform (GVP)-assisted campaign, outbound calls are 
dialed from GVP ports, and they can be completely processed and released by 
GVP. GVP issues information about call processing (such as call results and 
modified user data) to OBN Manager, which relays this information to OCS. 
OCS processes this information accordingly, applies any necessary treatments, 
and updates the records.
For more information about the messaging underlying the call flow, see 
“Detailed Typical Call Flow”.

Calculating the Number of Records

The procedure that OCS uses to calculate the number of records (or actual 
chains) to retrieve from the database when a proactive contact campaign is 
loaded differs from traditional Predictive, Progressive, or Preview modes. 
When a proactive campaign is loaded, OCS selects records for retrieval from 
the database based on the value of the MaxQueueSize parameter for the 
Campaign Group. If more than one calling list is used in the campaign, the 
number of records retrieved from each calling list is determined by the 
specified list weight that is set in Configuration Manager when the calling list 
is added to the campaign.
OCS then submits the records to OBN Manager using the following criteria:
• The total number of interactions or dialing requests submitted is equal to 

the MaxQueueSize value for the Campaign Group.
• OCS retrieves records from the calling list table in the database to 

replenish its buffer when the number of calling list records in the OCS 
buffer is below the minimum buffer size specified for the Campaign 
Group.

Do Not Call Records

OCS issues an EventOBNRecordStopProc message to OBN when it receives a 
DoNotCall request and determines that records are currently being processed 
by OBN. OBN immediately attempts to stop processing the specified record.

Detailed Typical Call Flow
1. Outbound Contact Server (OCS) uses an Outbound Notification (OBN) 

Manager Application to make an outbound call using GVP. When a Power 
GVP mode campaign is loaded in Outbound Contact Manager (OCM), OCS 
uses the RequestOBNRegisterClient and the EventOBNAdapterConnected 
messages to register with OBN Manager. 
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2. After a Power GVP mode campaign is started, OCS issues an outbound call 
request to GVP by sending a RequestOBNRecordStartDial message to OBN 
Manager for each record retrieved from a calling list. This message 
includes all dialing parameters and any UserData parameters. OBN 
Manager sends an EventOBNRecordStartDialAck message back to OCS 
when dialing has begun.

Note: UserData is sent in this request only. No user data is sent in any 
other requests.

3. OBN Manager forms an HTTP request to CFA, using the Start Dial 
parameters and the UserData attributes, in a NEW_SESSION_REQ message.

4. CFA processes the NEW_SESSION_REQ message from OBN Manager and uses 
a CREATE_LEG_REQ message to request IPCS/VCS to make an outbound call 
to the customer’s DN.

5. IPCS/VCS updates CFA with a Call Progress Analysis (CPA) result in the 
DIAL_AND_BRIDGE_DONE_REQ message.

Note: If the customer DN requests a call transfer to an agent, the call can be 
transferred by CTI or by the SIP REFER method on the platform.
To transfer a call using CTI:

Enable the CTI call transfer in the CFA section of EMPS. This 
enables a one-step call transfer from GVP to IServer.

To transfer a call using the SIP REFER method:
Enable the transfer type as OneSignalChannel containing the SIP 
REFER method as the Transfer Option in IVR Profile provisioning of 
EMPS.
Configure the Transfer Type in the CFA section of EMPS as 
Transfer on Platform. With this type of transfer, the SIP REFER 
request goes directly to SIP Server, and the transfer occurs on 
platform.

6. CFA updates OBN Manager with the following information:
The CPA result and the DN that it received from IPCS/VCS.
The UUID information that it received from the I-Server client.
In a deployment that includes a T-Server, CFA passes the T-Server 
Call GUID to OBN Manager as part of the user data. OBN Manager 
then passes the Call GUID to OCS as part of the RequestProcessing 
event information.

7. OBN Manager translates the CPA result from CFA into a call result that 
becomes the GSW_CALL_RESULT OCS key.
Proactive Contact—Solution Guide 61



Chapter 5: Proactive Contact Solution Reference Information Detailed Typical Call Flow
8. OBN Manager sends the information to OCS in the 
EventOBNRecordProcessing message. If the call result is CPA_NORMAL, IPCS/
VCS instructs an IVR application to begin processing the call. The 
application information is provided by OCS to GVP using the app_dbid 
attribute in the RequestOBNRecordStartDial message.

Note: The IVR application can be a Genesys Studio VoiceXML 
application or any another VoiceXML application. The IVR 
application information is provisioned in the Element Management 
Provisioning System (EMPS) in GVP.

9. The application-specific data is sent by the VoiceXML application to OBN 
Manager using the HTTP Post method. All the incremental data from the 
application is updated and saved locally by OBN Manager.

10. Once the application is successfully completed for the customer DN, IPCS 
sends an END_SESSION_REQ message back to CFA.

11. CFA ends the outbound call. It also translates the END_SESSION_REQ 
message into a call result, and updates OBN Manager that the outbound 
call has ended.

12. OBN Manager uses the EventOBNRecordProcessed message to inform OCS 
that the outbound call has ended. The EventOBNRecordProcessed message 
contains all updated UserData parameters, and is the last message from 
OBN Manager to OCS.
The EventOBNRecordProcessed message contains an important attribute 
named RecordAction, which identifies the outcome of record processing 
within GVP. The outcome can be one of the following: Processed, 
Rescheduled, Canceled, DoNotCall, Transferred.

13. When the campaign is unloaded, OCS closes the connection to OBN 
Manager and receives an EventOBNAdapterDisconnected message, which 
confirms OCS disconnection from OBN Manager.

Notes: If the VoiceXML application wants to reschedule a record for a 
different phone number than the one originally dialed, OBN Manager 
uses the RequestOBNAddRecord message. After OCS has added a new 
record containing the new phone number into the calling list, OCS 
acknowledges this request with an EventOBNAddRecordAck message.
If OCS wants to cancel processing a record that has already been 
dialed, OCS sends a RequestOBNRecordStopProc message to OBN 
Manager. OBN Manager responds with an EventOBNRecordStopProcAck 
message.
All error messages between OBN Manager and OCS use the 
EventOBNError message.
Any CTI communication between OCS and GVP uses the IServer 
client in GVP.
62 Genesys 7.6



Chapter 5: Proactive Contact Solution Reference Information OBN Error Codes
OBN Error Codes
Table 7 shows the error code and error text that OBN Manager sends to the 
trigger application if OBN fails to queue the input request.

Table 7: Error Codes and Error Text

Error Code Severity Description

100 FATAL Missing record handle

101 WARNING Missing application name

102 WARNING Missing customer name

103 WARNING Missing reseller name

104 FATAL Missing contact number

105 FATAL Missing TimeToLive value

106 FATAL Missing Maximum Attempts value

200 INFO Invalid Maximum Attempts value

201 INFO Invalid TimeToLive value

202 ERROR Invalid application name

203 ERROR Invalid customer name

204 ERROR Invalid reseller name

300 ERROR Maximum attempts exhausted

302 ERROR Time to live is exhausted

304 ERROR Application Queue size is exceeded

310 WARNING Request cannot be canceled because it is being 
processed

311 WARNING Record not found with the specified record handle

400 FATAL OBN database error

500 FATAL OBN shutdown in progress

501 FATAL OBN initialization is in progress

600 FATAL Undefined error
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